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Chapter 1. System requirements and
compatibility

Unica Journey is part of the Unica suite of products. Unica Journey version 12.1.3 requires
Unica Platform 12.1.3.

Where to find complete system requirement and compatibility information

For a list of Unica product versions compatible with Unica Journey and a list of third-party
requirements for this product, see the Recommended Software Environments and Minimum

System Requirements document.

You can also access this document by selecting Help > Product documentation when you

are logged in to Unica.

Prerequisites for using Unica Journey

Before you begin using Unica Journey, confirm that your environment meets the following

requirements:

« For an improved user experience, use at least a 21-i nch screen.

« For an improved user experience, set your screen resolution to 1600x900. Lower
resolutions can result in some information not being properly displayed. If you use a
lower resolution, maximize the browser window to see more content.

« Amouse is best for navigating in the user interface.

« Do not use the browser controls to navigate. For example, avoid using the Back and
Forward buttons. Instead, use the controls that are in the user interface.

« If pop-up blocker (ad blocker) software is installed on the client machine, Unica
Journey might not function properly. For best results, disable pop-up blocker software
while running Unica Journey.

« Ensure that the technical environment meets the minimum system requirements and
the supported platforms. For more information, see the Recommended Software

Environments and Minimum System Requirements document.
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» The correct browser and versions must be used. For more information, see the

Recommended Software Environments and Minimum System Requirements

document.

- Clear the browser cache after installation. This only needs to be done once, after the

application is updated.

Important: Do not use any other method to open multiple sessions. For example,

do not open a new tab; do not open another browser session from the Start menu

or desktop icon; and do not use File > New Window in Microsoft Internet Explorer.

These methods can corrupt information that is shown in the application.

Unica Journey documentation roadmap

Unica Journey provides documentation that helps users like marketers, administrators, and

developers to get their hands on the product functionality.

Table 1. Get up and running

Task

Documentation

Find out about the new features in the
product

For the first release, all new features are

available in the Unica Journey User Guide

Find out about the known issues and limi-

tations

Unica Journey Release Notes

Learn about the structure of the Unica

Journey system tables

Unica Journey System Schema

Installation and configuration of Unica

Journey

Unica Journey Installation Guide

Upgradation and configuration of Unica

Journey

Unica Journey Upgrade Guide
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Table 2. Installing and Configuring Unica Link

Task

Documentation

Installation and configuration of Unica
Link

Unica Link Installation Guide

Installing Unica Link connector app for

Journey

Unica Link Installation Guide

Installing Unica Link connector -
MailChimp

Unica Link Mailchimp Connector User
Guide

Installing Unica Link connector — Mandrill

Unica Link Mandrill Connector User
Guide

Installing Unica Link connector — Twilio

Unica Link Twilio Connector User Guide

Installing Unica Link connector — Sales-

force

Unica Link Salesforce Connector User
Guide

Table 3. Integrate Unica Campaign with other HCL products

Task

Documentation

Integration of Unica Campaign and Unica

Journey

Unica Campaign Administration Guide

and Unica Campaign User Guide

Integration of Unica Campaign and Unica
Interact

Unica Interact Administration Guide

Integration of Unica Deliver with Unica

Journey

Unica Journey User Guide

Integration of Unica Centralized Offer

Management and Unica Journey

Unica Journey User Guide
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Table 4. Get Help

Task Documentation

Unica Journey documentation You can get Unica Journey product doc-
umentation while you logged in Help >

Product documentation.

Unica Journey when installed with other Unica suite products
Before you start installation of Unica Journey you can refer to below sections to plan

Journey installation.

Note: Unica Journey does not support Silent-mode installation.

Unica Journey delivery engines for Email

Unica Journey supports Unica Deliver and Unica Link for email delivery. You can use any of
these integration as per your requirements. Please refer to documentation map section for

appropriate documents to refer on this integration.

Unica Journey stack support

Unica suite product support to third party software like databases, operating system,
application server etc., is not exactly same support with Unica Journey. Please refer to

Recommended Software Environments and Minimum System Requirements guide.

For example, If your existing Unica products are installed on stack as below:

* Operating System - AIX 7.1
« Application Server - WebSphere
« Database - DB2

You can install Unica Journey on supported environments as mentioned in Recommended
Software Environments and Minimum System Requirements guide and it would be

compatible with existing Unica products.
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Upgrading Unica products and Installing Journey

If you are upgrading from older Unica product version to 12.1.3, you can complete your

upgrade and then install Unica Journey 12.1.3.

Where to find documentation
You can find the documentation here.

* PDFs:
* Online Help:



Chapter 2. Prerequisites for Unica Journey
Installation or Upgrade

Before installing Unica Journey version 12.1.3, you have to ensure that a few prerequisites

are met.

If a you are a new user, and if you have HCL OneDB, MariaDB, or Microsoft SQL Server as the
database, you can directly install Unica Journey 12.1.3. Ensure that Unica Platform version

12.1.3 is operating correctly.

The supported upgrade path for Unica Journey 12.1.3 are as follows:

Table 5. This table describes the topics that are included in the Unica Journey

Upgrade Guide and the list of sub-topics in the second column.

Base Journey version Upgrade path Tasks to be performed
In case of Oracle, the base |In case of Oracle, the up- 1. Upgrade Unica Mar-
Unica Journey can be: grade path can be: keting Platform to
12.1.3
*12.1.x *121.x~-12.1.3 2. Run upgrade Unica
*12.1.0.x *12.1.0x ~>12.1.3 Journey to 12.1.3 in-
staller

In case of Microsoft SQL In case of Microsoft SQL )
3. Configure Journey

Server, MariaDB and Server, MariaDB and L
application

OneDB, the base version is | OneDB, the upgrade path )
4. Deploy Journey appli-

12.1.0.3 and later. is: )

cation

©12.10x - 12.1.3 5. Run Journey applica-

tion
Clean Installing Journey on | In place upgrade to Unica 1. Upgrade Unica Mar-
existing Unica environment | Journey 12.1.3 keting Platform and
when you have system ta- required Unica prod-
bles as OneDB, MariaDB ucts to 12.1.3 except

and SQL Server databases Journey.
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Table 5. This table describes the topics that are included in the Unica Journey

Upgrade Guide and the list of sub-topics in the second column. (continued)

2. Run clean installer of
Unica Journey 12.1.3

3. Configure Journey
application

4. Deploy Journey appli-
cation

5. Run Journey applica-

tion

Note:

1. If Journey is not already installed on an existing Unica environment with
Oracle database, install Unica Journey version 12.1.0 and upgrade to Unica
Journey version 12.1.3. If Journey is already installed and the Journey version
is 12.1.0, follow the upgrade path mentioned in the earlier table.

2. If you do not have Journey already installed on existing Unica environment
with either MS SQL Server, OneDB or MariaDB database then you can install

Journey version 12.1.3 directly as clean install.

To prerequisites for installation, or upgrade, of Unica Journey are as follows:

1. Ensure that all users are logged out.

2. Stop Unica Journey, Unica Platform, and all applications that are deployed with it.
Also, stop all other components, for example Journey Engine, Kafka server, etc.

3. Undeploy Unica Platform and Unica Journey web application from the application
server.

4. Stop the application server and clean the application server cache.

5. Back up the Unica Platform and Unica Journey database and file system directory to

any temporary directory.



Chapter 3. New features and changes in
version 12.1.3

In Unica Journey 12.1.3, we have introduced some new features, and we have made

changes to some existing features or functionality.

The following list mentions the support for new platforms, in Unica Journey 12.1.3:

* Supports IBM WebSphere Application Server and Red Hat JBoss Enterprise
Application Platform.

« Supports Kafka on windows operating system. To configure Kafka on
Windows operating system, see https://support.hcltechsw.com/csm?
id=kb_article&sysparm_article=KB0085551.

The following list mentions the new features, and the changes to existing features, in Unica

Journey 12.1.3:

« Log4j Security vulnerability fixes

Unicav12.1.3 now uses | og4j v2.17.1. This version addresses the critical
vulnerabilities identified in | og4j . It includes the security fixes mentioned in the

following Unica Knowledgebase article:
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0095491

For more details related to the fixes in | og4j 2. 17. 1, see https://logging.apache.org/
log4j/2.x/security.html.
« Mask PS data on Journey Ul

Customer specific private information can now be masked from display in the Journey
Ul. This allows user to specify which DD fields to mask in the Journey Ul and they will
be displayed with random characters masked out. For example Email will be displayed
as S*****@g**.C**

« Add Failure status to all failed calls in the Journey in Stats list view


https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0085551
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0085551
https://support.hcltechsw.com/csm?id=kb_article&sysparm_article=KB0095491
https://logging.apache.org/log4j/2.x/security.html
https://logging.apache.org/log4j/2.x/security.html
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As a marketer, there's a need to know why some of the connectors fail during
execution. The Stats List view will now display reason for failures - like "Required
fields missing" or "Bad Request", etc. when connectors fail during execution

Add reason for Rejected records on Stats view on Journey

Journey Stats View now displays reason why some records are rejected during
Journey execution like Invalid Email id, Invalid mobile, Required field missing etc

Disable Email and SMS validation based on a flag

A global flag is now added to DISABLE validations during Journey records processing
- like email format, data type checking, etc. This allows Journey execution without
validations.

Old template files have been renamed to match their description

The Journey accelerators in earlier release were not given appropriate names to
match what their functionality is. This has been resolved now with meaningful names.

Improve Journey logging for better troubleshooting including Journey specific logs

Journey application logging has been improved now to provide more details for
troubleshooting and debugging issues, including Journey specific log files.
While configuring any deliver touchpoint a need preview of communication from

Journey is available

While configuring any deliver touchpoint preview of communication from Journey is
now provided. This is available in the communication list to verify the communication
selected. This allows to preview what the end communication will look like before
executing the Journey

Changed Push ID to Install ID

In create Data Definition page, the Journey significant field Push ID is renamed to
Install ID to maintain consistency across all Unica products.

Journey Audience archival

For audiences whose Journey has ended, their details are moved to another table to
improve performance in all Touchpoints and Journey Controls. The archival does not
impact the statistics and reports.



Chapter 4. Fixed Defects

The following table lists the defects fixed in Unica Journey 12.1.3:

Defect ID Description

HMA-335317 Error deploying Journey.war in the Websphere

HMA-334057 Journey converts numeric to exponential value when the
number is length more than 7

HMA-334880 VER :-v12.1.2: IFO1 audience stuck in at journey event topic
after upgrade

HMA-335204 Version - HF- Journey Engine logs increasing continuosly

HMA-337221 Web/Engine Application property contain journey.ver-
sion=12.1.2

HMA-335202 Version - HF- Rejected audience count not available on stats
view

HMA-335205 Version - HF testing - Decision split and Publish touchpoint
not processing the data

HMA-329972 Time taken for journey audience processing degraded as
compared to previous version - ENH

HMA-335206 Version - HF_12.1.2-Control Center- If Channel capacity is
not available for any channel - in journey its not showing
message for capacity - its showing message regarding in-
valid time

HMA-335208 Version - Journey with preferences configured on timezone
and channels - When template is created with this journey,
new journey does not have the preferences at journey level
nor at the touchpoints



Chapter 5. Known issues

The following table lists the known issues in Unica Journey 12.1.3:

Defect ID Known Issue

HMA-338565 In OneDB, the error message column does not populate val-
ues for Mailchimp despite throwing error message in in-
coming response topic and data error table.

HMA-338531 In case of Microsoft SQL Server, when upgrading Journey
from 12.1.0.3 to 12.1.1, Performance Reports do not work
correctly due to the trigger issue.

HMA-338514 Journey is not getting copied if it has a Link connector.

HMA-338387 For version 12.1.3, the copyright year is incorrect in the Fed
Response File ResponseFi | es. tar. gz.

HMA-336307 Disable_Validations_On_Journey_Records: No -> With this
settings Data greater than set length should get rejected
but getting accepted

HMA-334560 offsets.topic.replication.factor=1 property from the kafka
server.properties get commented in clean as well as over-
write installation.

HMA-333396 Journey - Mobile app change from deliver end

HMA-330727 ORA-02264: name already used by an existing constraint
displayed while executing the JourneyReportOracleCreate-
Tables.sql on oracle 12c on single schema for Journey

HMA-334286 Document: HMA-33254- Global Preferance: For non set
communication days on journey stats its showing waiting
reason as "Invalid communication time"

HMA-334480 Facebook version for 12.1.1 and 12.1.2is V11.0
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Defect ID Known Issue

HMA-334130 Journey system schema procedure need to compiled manu
ally on Oracle Database.

HMA-334459 Zookeeper installed by Journey installer is not getting start-
ed

HMA-334549 Edit issue when single external source is mapped to same
journey entry source

HMA-334614 When Journey that has preferences configured on Journey
or in any touchpoints and then template is created from this
Journey and new Journey is created the Journey will not
have any preferences retained

HMA-333490 REGBB- (Docker Tomcat) For linkedin not showing states
count

HMA-334727 Journey not recommends to edit the global preference time
zone in Contact center if that GP is configured with Journey

HMA-335161 User is logged out when tried to access Kafka type of Entry
Source- as a workaround please check if asset picker is in-
stalled and correctly configured

HMA-338024 Maria DB- Not getting deliver responses in journey as
unique constraints are not working for null xid

HMA-338440 12.1.3 - Getting error on running gdpr utility since three
log4j jars (log4j-api-2.17.1,log4j-core-2.17.1,log4j-1-
.2-api-2.17.1) are missing from GDPR lib folder- as a
workaround plz copy log4j-api-2.17.1,log4j-core-2.17-
.1,log4j-1.2-api-2.17.1 under GDPR lib folder

HMA-337225 Web and engine application properties - properties are get-
ting merged after updating or upgrading the build

HMA-337881 Journey audiences archival speed needs improvement




Unica Journey V12.1.3 Release Notes | 5 - Known issues | 13

Defect ID Known Issue

HMA-337336 Journey uninstallation did not remove all the files which is

lay down by the installer

HMA-334502 Unable to Publish paused Journey when milestones added
and Duplicate records are allowed in Journey settings

HMA-337222 Error message column did not populated for Mailchimp al-

though we get Error message in incoming response topic




Chapter 6. Before you contact HCL technical
support

If you encounter a problem that you cannot resolve by referring the documentation, your
company's designated support contact can log a call with HCL technical support. Use these

guidelines to ensure that your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your HCL

administrator for information.

Information to gather

Before you contact HCL technical support, gather the following information:

« A brief description of the nature of your issue.

« Detailed error messages that you see when the issue occurs.

« Detailed steps to reproduce the issue.

« Related log files, session files, configuration files, and data files.

« Information about your product and system environment, which you can obtain as

described in "System information."

System information

When you call HCL technical support, you might be asked to provide information about your

environment.

If your problem does not prevent you from logging in, much of this information is available

on the About page, which provides information about your installed HCL applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check foraver si on. t xt file that is located under the installation directory for

your application.

Contact information for HCL technical support
For ways to contact HCL technical support, see the HCL technical support website:

https://www.hcltech.com/products-and-platforms/contact-support


https://www.hcltech.com/products-and-platforms/contact-support
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